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Preface

Preface

Welcome to the Trend Micro Encryption for Email User’s Guide. This manual contains 
information about product settings and features.

Topics in this section include: 
• Trend Micro™ Encryption for Email Documentation on page vi
• Audience on page vi
• Document Branding on page vi
• Document Conventions on page 1-vii
v
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Trend Micro™ Encryption for Email 
Documentation

The Trend Micro™ Encryption for Email documentation consists of the following:

Online Help—Helps you configure all features through the user interface. You can 
access the online help by clicking the Encryption for Email tray Help icon ( ).

User’s Guide—Helps you plan for deployment and configure all product settings. 

Readme File—Contains late-breaking product information that might not be found in 
the other documentation. Topics include a description of features, installation tips, 
known issues, and product release history. 

The User’s Guide and readme are available at:
http://www.trendmicro.com/download

Audience
This document is targeted to new users of Encryption for Email, including system 
administrators, operators, sensitive content contributors, information security staff, 
executives, and users with other specific roles.

In order to use Encryption for Email, you need to be familiar with web browsers and 
web-based user interfaces.

Document Branding
This document, including the images displayed herein, as an example, have been 
branded for use by Trend Micro. The look and feel of your documentation and user 
interface will appear differently depending on your company’s branding requirements.
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Document Conventions
To help you locate and interpret information easily, the Encryption Client 
documentation uses the following conventions.

Note:

Tip:  

WARNING!

CONVENTION DESCRIPTION

ALL CAPITALS Acronyms, abbreviations, and names of certain 
commands and keys on the keyboard

Bold Menus and menu commands, command buttons, 
tabs, and options

Italics References to other documentation

Monospace Examples, sample command lines, program 
code, web URL, file name, and program output

Configuration notes

Recommendations

Reminders on actions or configurations that 
should be avoided
vii
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Chapter 1

Introducing Encryption for Email

Topics include:
• Installing Encryption for Email on page 1-3
• System Requirements on page 1-2
• Protecting Your Email Address on page 1-16
• Checking for Updates on page 1-20
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Introduction
Trend Micro Encryption for Email is a user-friendly, high-level privacy system.

If you know someone’s email address, you have all the information you need to send 
them a message, safe in the knowledge that only they will be able to read it. You simply 
click a button and send your email as usual.

Also included in the system are digital signatures so that your recipient knows that the 
message has come from you and has not been tampered with. File attachments are 
protected along with your email message, and you can send messages in plain text, Rich 
Text Format (RTF), or HTML.

Note: This system is completely safe. At no point do Trend Micro employees have access to 
the content of your email messages. 

System Requirements

Hardware and Operating System
Minimum computer requirements are:
• Intel Pentium 800MHz processor
• Microsoft Windows XP 32-bit SP3 (English) Home, Professional, Media Center
• Windows Vista 32-bit and 64-bit SP2 (English) Home Basic, Home Premium, 

Business, Enterprise, Ultimate
• Windows 7 32-bit and 64-bit (English) version 6.1, Home Basic, Home Premium, 

Professional, Enterprise, Ultimate
• 256MB RAM required, 512MB recommended
• 50MB available disk space

Email Clients
You must have one of the following email programs to encrypt email messages with 
Encryption for Email:
• Microsoft Outlook 2002, 2003, or 2007 (all 32-bit, English)
• Windows Live Mail 2009 32-bit (English)
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Encryption for Email supports the following web-based email clients:
• Gmail (English)
• Hotmail (English)
• Yahoo Mail (English)

Web Browsers
Encryption for Email supports the following web browsers:
• Microsoft Internet Explorer 7 (x86-32) and 8 (x86-64)
• Mozilla Firefox 3.6 (x86-32)

Mail Servers
• Microsoft Exchange Server 2003 SP2 Standard, Enterprise
• Microsoft Exchange Server 2007 SP3 Standard, Enterprise
• Microsoft Exchange Server 2010 version 14 Standard, Enterprise

Installing Encryption for Email
The installation is a three-stage process as follows:
1. Downloading the Encryption for Email Software
2. Completing the Installation Wizard
3. Protecting Your Email Address

Downloading the Encryption for Email Software
In order to read and write messages in Encryption for Email, you need to install it. You 
must first download the Encryption for Email software.
1. Point your browser to the Trend Micro Download Center, at:

http://downloadcenter.trendmicro.com/index.php?prodid=88

The Trend Micro™ Encryption for Email download screen opens.
2. In the File Name column, click the Trend Micro Encryption for Email link. 

Your browser prompts you to save or run the file.
1-3
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3. Click Save and specify a local folder.
The Encryption for Email software is downloaded.

4. Open the downloaded file, TMEEC.exe.

A Windows Security Warning appears when the download completes.

FIGURE 1-1.   Security Warning Screen

Note: To view Encryption for Email digital signature information, click the 
Trend Micro, Inc. link next to “Publisher.”
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FIGURE 1-2.   Installation Wizard splash screen

5. Click Run.
The splash screen displays and Trend Micro Encryption for Email examines your 
system environment to verify whether it meets the minimal installation 
requirements.
• If the computer does not meet the minimal requirements, the installation halts.
• If the computer meets the minimal requirements, the Installation Wizard starts.
• If your system currently has an installation of Microsoft Outlook Express with 

an Encryption for Email plug-in, the installer displays a message informing you 
that Outlook Express is no longer supported, along with a link to download 
Windows Live Messenger, as shown in Figure 1-3.

FIGURE 1-3.   Outlook Express is no longer supported
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6. Click Install. 
The installer checks to see if you have the latest Microsoft Outlook service pack 
and, if not, recommends that you install it, as shown in Figure 1-4.

FIGURE 1-4.   Outlook service pack reminder

7. If you see the message shown in Figure 1-4, click No to exit the installation, install 
the latest Outlook service pack, and then restart the installation program.

Completing the Installation Wizard
The Encryption for Email Installation Wizard helps you to install the software quickly 
and easily.

Note: Before installing Encryption for Email, ensure that you have closed Microsoft 
Outlook and Microsoft Word and that you are connected to the Internet.
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FIGURE 1-5.   Encryption for Email License Agreement screen

To install the software:
1. Follow the steps shown in Downloading the Encryption for Email Software on page 1-3. 

The License Agreement screen appears, as shown in Figure 1-5.
2. Select your home country from the list shown.
3. Select I accept the terms in the license agreement and click Next. The License 

Product screen appears.

Note: If you do not accept the terms of the license agreement, the installation will halt.
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FIGURE 1-6.   License Product screen

4. Select your license type as follows: 
Home user (non-commercial use): Select this option if you are a home user or if 
you are installing Encryption for Email for non-commercial use. 
 
Free 30-day trial: Select this option if you are installing on a trial basis. 
 
Enter activation code: If you have purchased Encryption for Email, select this 
option and type your activation code.
See Licensing Options on page 1-15 for more information about license types.

5. Click Next.
The Install Type screen appears.
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FIGURE 1-7.   Install Type screen

Note: To change the installation path, click Custom Install.

6. Click Next.
The Gathering Information (Step 1 of 2) screen appears.
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FIGURE 1-8.   Gathering Information, Step 1 of 2 screen

To register your first “identity” with Encryption for Email, you must have the following 
information.
7. Type your email address in the following fields:

• Email
• Confirm
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8. Type your password in the following fields:
• Password
• Confirm

Note: Watch the password strength meter to the right of the password fields to ensure 
that you create a strong password that is difficult for a hacker to crack.

9. Click Next.
The second Gathering Information screen appears.

FIGURE 1-9.   Gathering Information, Step 2 of 2 screen

10. Type an identification word in the Identification word field.
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Note: Your identification word is displayed whenever you are asked to sign into My 
Private Post or the Private Post Zero Download website. It helps you to verify 
that you are not on a phishing site.

11. Select a question from the Question 1 drop-down list and type your answer in the 
Answer field. (See Security Questions and Answers on page 1-15 for information about 
why you need to set up these question/answer pairs.)
Repeat for questions 2 and 3.

Note: Completing this information does not register the product.

12. Click Next.
A screen appears showing the progress of the installation, as shown in Figure 1-10.

FIGURE 1-10.   Installing packages progress bar

When the installation is finished, Encryption for Email sends an activation email to 
the email address that you entered and prompts you to access it, as shown in 
Figure 1-11.
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FIGURE 1-11.   Activation email sent

13. Click Open Email to open your email client, and then click the activation link in 
the activation email.

Tip:  If you do not receive the activation message within a minute or so, check your 
Spam folder. Such messages often end up there.
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14. Encryption for Email completes the registration process and displays the screen 
shown in Figure 1-12.

FIGURE 1-12.   Final Private Post registration screen

You can now begin sending encrypted messages and decrypting (reading) messages 
sent to you at the email address that you just registered.
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Security Questions and Answers
When installing Encryption for Email—and when registering an email—you must select 
and answer three “security questions.” Select questions and simple answers that you will 
be able to remember easily, because you will need to answer these questions again:
• When you log in to the My Private Post website, as described in My Private Post on 

page 5-2
• To log in to the Private Post Zero Download server to read email on a computer 

that does not have the client installed, as described in Using the Zero Download Reader 
on page 3-2

• If you forget your password and need to reset it

The “identification word” displayed in the Security Questions screen is the one that you 
entered when you first registered this email address with Encryption for Email. The 
identification word assures you that the server that you are connecting to is actually the 
Encryption for Email server.

Licensing Options
Commercial users have a number of licensing packages available to them, including 
batch licensing. See your authorized Encryption for Email representative for additional 
information on a licensing package that best suits your commercial needs.

Trial Basis
If you are installing Encryption for Email on a trial basis, click Free 30-day trial when 
the License Type screen displays. When you select the free trial, you are entitled to use 
Encryption for Email for up to 30 days. You can register up to five email addresses on 
the same domain, for example:
• adam@example.com

• tess@example.com

• polly@example.com

• dan@example.com

• ilsa@example.com

Email Address Lockdown
The sixth email addresses on the domain—and any additional ones above six—will be 
“locked down” such that you cannot encrypt messages for those addresses. After the 
trial period expires, all the addresses registered during the free trial will be locked down.
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“Lockdown” means that an Encryption for Email account will no longer be able to 
encrypt emails. You can still decrypt email messages, but you cannot encrypt them or 
use any of the other advanced features.

Protecting Your Email Address
Trend Micro Encryption for Email must have your registered email identities in order to 
work. When you register an email address, Encryption for Email acquires a set of 
encryption keys that are unique to you and your registered and confirmed email address. 
Without these keys, Encryption for Email cannot make your email private. For a more 
detailed discussion, see Managing the Encryption for Email Keys on page 4-9.

Note: In addition to use in logging in, this email address will not be used only for 
notifications directly related to use of this product, for example password reset or 
registration notification. It will not be used for marketing purposes, nor sold to any 
other party. You will not receive spam as a result of registering Encryption for Email.

You can register as many email addresses as you like. Each address will receive a new 
private key each month. To save you time, the installation program registers the first 
address for you.

When you install Encryption for Email, you automatically obtain your private key. Your 
email address is then used as your unique email identity for use with the private 
encryption key.

Registering Your Email Address
You may register an email address under several conditions and from different places, 
for example:
• When installing the software (as described in Completing the Installation Wizard  

starting on page 1-6)
• When clicking Protect Another Email Address from the Encryption for Email 

system tray icon( ) (as described in Registering on an Existing Encryption for Email 
Installation on page 1-17)

• When attempting to decrypt an encrypted email message sent to an unregistered 
email address (as described in Registering on the Web on page 3-16)
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You can install and obtain the Encryption for Email keys on one or more computers. 
See Using Encryption for Email on Multiple Computers for more information about using the 
software on more than one computer.

You need to register your email address to do any of the following:
• Log on to My Private Post to configure your personal options. (See My Private Post 

on page 5-2  for more about configurable options.)
• Log on to the Private Post Zero Download website to read encrypted email 

messages using a web browser instead of using an installation of Encryption for 
Email. (See Reading a Private Email Message on page 3-4 for more about this method.)

• Register the same email addresses on another computer and perform an automatic 
transfer of registrations.

Using Encryption for Email on Multiple Computers
It is possible to install and use Encryption for Email on more than one computer using 
the same email address.

You might want to register on multiple computers if:
• You are not a registered user and want to use a computer that has an installation of 

Encryption for Email
• You are a registered user but the computer you want to install on:

• Does not have an installation of Encryption for Email
• Already has an installation of Encryption for Email, which is registered to 

another user

Registering on an Existing Encryption for Email Installation
Use this process if you are not an existing Encryption for Email user but the computer 
you want to use for Encryption for Email already has the software installed.
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To register on an existing Encryption for Email installation:

1. Click the Encryption for Email icon ( ) in the Windows system tray. In the pop-up 
menu that appears, select Protect Another Email Address.

FIGURE 1-13.   Protect Another Email Address Option on the Encryption 
for Email Menu

2. The Encryption for Email Protection Wizard opens.
3. Complete the Encryption for Email Protection Wizard. See Registering Your Email 

Address for help with completing the Wizard.

Installing As an Existing User
Follow this process if you are an existing Encryption for Email user but the computer 
you want to use does not have Encryption for Email installed.

To install Encryption for Email as a Registered User:
1. Install Encryption for Email, as discussed in Installing Encryption for Email on 

page 1-3.
2. Type your Email Address and Password. When you enter your email address, 

Encryption for Email detects that this address is already being used and so requires 
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you to log in to transfer the registration. After the registration has been transferred, 
you begin to receive your private keys, as on the other computer. The Security 
Questions screen appears.

FIGURE 1-14.   Security Questions screen

3. In the Answer fields, type the answers to the security questions shown.
4. Click Next.
5. Open your email and complete the process.
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Checking for Updates
Encryption for Email provides an automatic software update facility. There are a 
number of ways in which this facility is invoked:
• Periodic Auto Updates
• Manual Auto Updates

Periodic Auto Updates
Encryption for Email automatically checks your local files against files on the 
Encryption for Email web server:
• 10 minutes after the Encryption for Email service starts (for example, 10 minutes 

after you log on)
• Every 24 hours, if the Encryption for Email service is running continuously

This check runs in the background. You are only notified if there are updates available. 
If an update requires that you restart your computer, Auto Update prompts you.

Manual Updates
You can check for updates to Encryption for Email manually whenever Encryption for 
Email is running.

To check for software updates manually:

1. Click the Encryption for Email icon ( ) in the Windows system tray. An 
Encryption for Email pop-up menu appears.

2. Select Check for Updates.
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To view the Encryption for Email Modules screen from the About Encryption for 
Email window:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email pop-up menu appears.

2. Select About from the menu. The About Encryption for Email window appears.
3. Click Modules. The Encryption for Email Modules window appears, displaying a 

list of modules and their version numbers.
1-21



Trend Micro Encryption for Email User’s Guide
1-22



Chapter 2

Using the Encryption for Email Client

Topics include:
• Using Encryption for Email on page 2-2
• Sending and Receiving Private Mail Using an Email Program on page 2-2
• Encryption for Email Applications on page 2-8
• Using the Encryption for Email Tray Tool on page 2-9
• Working with Files on page 2-28
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Using Encryption for Email
Encryption for Email effectively puts your email in an envelope, ensuring that only the 
recipient reads it. Encryption for Email enables you to:
• Send and receive private email using a plug-in for your email program, as described 

in Using Encryption for Email in Your Email Program on page 2-2
• Read private emails using a web mail service, for example, GMail, as described in 

Using the Zero Download Reader on page 3-2
• Read and write private files and information on your local hard disk, as described in 

Using the Encryption for Email Tray Tool on page 2-9

Sending and Receiving Private Mail Using an 
Email Program

You can send and receive private messages and attachments using an Encryption for 
Email toolbar that integrates with Microsoft Outlook to provide enhanced features.

Note: Trend Micro Encryption for Email no longer supports Microsoft Outlook Express. 
You can easily update to Windows Live Mail on the Microsoft website.

Using Encryption for Email in Your Email Program
There are two toolbars that plug in to your email program when you have installed 
Encryption for Email. They are:
• The Encryption for Email Main Menu Bar: displayed in the main window of your email 

client.
• The Encryption for Email Toolbar: displayed in the Send and Receive message windows.
2-2



Using the Encryption for Email Client
The Encryption for Email Main Menu Bar
The Encryption for Email Main Menu Bar appears in your main email client window. 
The features available on this menu are:
• Preferences (see Accessing the Preferences Screen on page 4-2)
• My Private Addresses (see My Private Addresses on page 2-12)
• About (see The About Encryption for Email Window on page 4-17)

FIGURE 2-1.   Encryption for Email Main Menu Bar

Note: The Encryption for Email Main Menu Bar shown in Figure 2-1 is from Microsoft 
Outlook 2003. The appearance of this menu may vary depending on your email client 
and operating system.

The Encryption for Email Toolbar
The Encryption for Email Toolbar appears in your Write and Read messages windows. 
The features available on the toolbar vary according to whether you are:
• Sending Private Messages and Attachments
• Reading Private Email

Sending Private Messages and Attachments
You can send private emails using your email program. You can make email messages 
and their attachments private in three ways: 
• Clicking Send Private on the Encryption for Email toolbar
• Clicking Make Private on the Encryption for Email toolbar prior to sending the 

email
• Configuring the Email Options to make new messages private by default, as 

described in Preferences Screen Email Options Tab on page 4-4
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Note: If you are using Microsoft Outlook and the “Always check spelling before sending” 
option is selected, you cannot use Send Private to send private messages. Turn off that 
setting to use Encryption for Email.

The Encryption for Email toolbar in the Write message window contains the following 
functions:
• Send Private: Makes the message and attachments private and sends the message
• Make Private: Marks the message and attachments so that they will be made private 

when the message is sent

FIGURE 2-2.   Encryption for Email toolbar when composing an email 
message

Note: The Encryption for Email toolbar shown in Figure 2-2 is from Microsoft Outlook 
2003. The appearance of this toolbar may vary depending on your email client and 
operating system.

To send a private email using Send Private:
1. In your email program, click New to open a new message window.
2. Type your message and add attachments if required.
3. In the Encryption for Email toolbar, click Send Private. Encryption for Email 

encrypts the message and the private email is sent.

Note: If you have not selected “Enable remembering of passwords” in your Encryption for 
Email Password Options, you must also enter your password before the email is sent, 
as described in Preferences Screen Email Options Tab on page 4-4.
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To send a private email using Make Private:
1. In your email program, click New to open a new message window.
2. In the Encryption for Email toolbar, click Make Private.
3. Type your message and add attachments if required.
4. Click Send in your email program. Encryption for Email encrypts the message and 

sends the private email.

Reading Private Email
You can open encrypted email messages and attachments sent to you as long as you have 
registered your recipient email address.

Even if you do not have the private key, if you are connected to the Internet and you 
have completed the registration for that email address, Encryption for Email gets the 
key from the server on demand.

You can also Reply, Reply To All and Forward private email. Any private email that you 
receive remains private when replied to or forwarded. You can forward and reply using 
the regular buttons in your email program.

The Encryption for Email toolbar in the Read message window provides the following 
functions:
• Open/Show Envelope: enables you to toggle between reading your private 

message and hiding it behind the Encryption for Email envelope.
• Signature: displays the digital signature details of the sender so that you can verify 

that the sender name shown is the actual sender.
• View Message Source: displays the MIME code behind the email message. Short 

for Multipurpose Internet Mail Extensions, MIME is a specification for formatting 
non-ASCII messages so that they can be sent over the Internet.

FIGURE 2-3.   Encryption for Email toolbar when reading private messages

Note: The Encryption for Email toolbar shown in Figure 2-3 is from Microsoft Outlook 
2003. The appearance of this toolbar may vary depending on your email client and 
operating system.
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To read a private email message:
1. Open the message containing the text to read. The “Encryption for Email: Please 

enter your password” window appears.

FIGURE 2-4.   Encryption for Email: Please enter your password 
window

Note: If you have the “remember passwords” option enabled (Preferences > Password 
Options), the password window will appear only when necessary.

2. If more than one email address is registered for the current installation, select your 
email address from the list of available email addresses.

3. Type your password and click OK. 
• If in your Encryption for Email Preferences, “Automatically open the 

encrypted message” is selected (the default setting), the decrypted message 
content displays, as shown in Figure 2-5.

• If “Automatically open the encrypted message” is not selected, the message 
opens showing the Private Post envelope.

4. If the envelope is showing, click Open Envelope in the Encryption for Email 
toolbar. The message view switches to display the decrypted message content, as 
shown in Figure 2-5.
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FIGURE 2-5.   A Decrypted Encryption for Email message
2-7



Trend Micro Encryption for Email User’s Guide
Encryption for Email Applications
Encryption for Email consists of the following applications:
• Encryption for Email Tray Tool, as described in Using the Encryption for Email Tray 

Tool on page 2-9
• Encryption for Email Protection Wizard, as described in Protecting Your Email 

Address on page 1-16
• Encryption for Email Key Manager, as described in Managing the Encryption for 

Email Keys on page 4-9
• Encryption for Email Uninstaller, as described in Removing Encryption for Email on 

page 5-6

After installing Encryption for Email, you can access each of these applications through 
the Windows Start menu. You can access the most commonly used Encryption for 
Email applications also from the Encryption for Email Tray Tool menu, as described in 
Using the Encryption for Email Tray Tool on page 2-9.

To open an application in Encryption for Email:
1. Click Windows Start.
2. Select All Programs > Trend Micro Encryption for Email.
3. Select the desired application.
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Using the Encryption for Email Tray Tool
Using the Encryption for Email Tray Tool, you can perform several functions. The tool 
menu contains the following choices:
• About Encryption for Email, as described in The About Encryption for Email 

Window on page 4-17
• Help: opens the Online Help
• My Private Addresses, as described in My Private Addresses on page 2-12
• Protect Your/Another Email Address, as described in Protecting Your Email 

Address on page 1-16
• Change your Password, as described in Changing Your Password on page 2-13
• Clipboard, as described in Working with the Clipboard on page 2-14
• Window, as described in Working with Windows on page 2-22
• Forget Passwords, as described in Removing Cached Passwords on page 2-24
• Preferences, as described in Accessing the Preferences Screen on page 4-2
• Check for Updates, as described in Checking for Updates on page 1-20
• Shutdown, as described in Closing Encryption for Email on page 2-25

Additional menu options are available through the Encryption for Email Advanced 
menu, as described in The Encryption for Email Advanced Menu on page 2-10.

To open the Encryption for Email Tray menu:

• In the Windows system tray, click the Encryption for Email icon ( ). The 
Encryption for Email menu appears.
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FIGURE 2-6.   Encryption for Email system tray pop-up menu

The Encryption for Email Advanced Menu
The Encryption for Email Advanced menu provides access to commands used by 
Encryption for Email support for diagnostic purposes.

The advanced menu contains these additional menu choices:
• Status, as described in The Encryption for Email Status Screen on page 2-25
• Key Manager, as described in Managing the Encryption for Email Keys on page 4-9
• Support Tools, as described in Support Tools on page 2-11

To open the Encryption for Email Advanced menu:

• Hold down the Ctrl key and click the Encryption for Email icon ( ) in the 
Windows system tray. The Encryption for Email Advanced menu appears.
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FIGURE 2-7.   Encryption for Email Advanced Menu

Support Tools
The advanced Encryption for Email tray tool menu includes a parent menu called 
Support Tools, as shown in Figure 2-8. It contains the following two items:
• Diagnostic Tool
• Trace Log

You do not need to use these options to use Encryption for Email. They are provided 
only for use by technical support. Do not use them unless directed to by your support 
provider.
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FIGURE 2-8.   Encryption for Email tray tool advanced menu, showing 
Support Tool items 

My Private Addresses
The My Private Addresses screen displays the Encryption for Email addresses that are 
registered on the current computer. From this screen you can see which email addresses 
have been registered for use with Encryption for Email and which ones are partially 
registered. You can also launch the Encryption for Email Protection Wizard to protect a 
new email address.

To view the My Private Addresses screen:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email pop-up menu appears.

2. Select My Private Addresses. The My Private Addresses screen appears.
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FIGURE 2-9.   Encryption for Email Protected Email Addresses screen

To launch the Encryption for Email Protection Wizard:
• From the Protected Email Addresses screen, click Protect Email Address.

Changing Your Password

To change your password:

1. In the Windows system tray, click the Encryption for Email icon ( ). The 
Encryption for Email pop-up menu appears.

2. Select Change Your Password. The Encryption for Email Change Password 
screen appears.
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FIGURE 2-10.   Encryption for Email Password Change screen

3. If you have more than one email address registered, select the email address whose 
password you wish to change from the drop-down list.

4. Type your Old Password, New Password, and then Confirm the new password.
5. Click OK twice.

Note: To change your security questions and answers, see My Private Post on page 5-2.

Working with the Clipboard
You can make the contents of the Windows Clipboard private. You can also:
• Read contents of the Clipboard that have previously been made private
• Edit text contained on the Clipboard
• Empty the contents of the Clipboard

The Clipboard submenu contains the following options:
• Empty, as described in Emptying the Clipboard on page 2-15
• Edit, as described in Editing the Contents of the Clipboard on page 2-16
• Make Private, as described in Making the Contents of the Clipboard Private on page 2-17
• Sign, as described in Digitally Signing the Contents of the Clipboard on page 2-19
• Decrypt/Verify, as described in Reading the Contents of the Clipboard on page 2-20
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Using Encryption for Email, you can make files private by using both the Encryption 
for Email menu and the Make Private menu option in Windows Explorer. For a more 
detailed discussion of using Windows Explorer to decrypt Clipboard content, see 
Making the Contents of the Clipboard Private on page 2-17 and Making Files Private with 
Windows Explorer on page 2-28.

Note: Only supported Clipboard data formats—ANSI text or entire files—can be made 
private using Encryption for Email. If an unsupported format is on the Clipboard, the 
menu options will be disabled.

Emptying the Clipboard
You can use this feature if you have several items in the Clipboard but want to encrypt 
only a specific file or piece of information. You can empty the Clipboard and then add 
only the information to make private, as described in Making the Contents of the Clipboard 
Private on page 2-17.

To empty the Clipboard:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Clipboard > Empty, as shown in Figure 2-11. Encryption for Email deletes 
all Clipboard contents.
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FIGURE 2-11.   Encryption for Email tray icon menu showing Clipboard 
submenu

Editing the Contents of the Clipboard
You can use this feature to edit text on the Clipboard. For example, you could copy a 
text document to the Clipboard and then add or remove parts of that document without 
editing the original.

To edit the contents of the Clipboard:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Clipboard > Edit. The “Encryption for Email: Viewer” screen appears.
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FIGURE 2-12.   Encryption for Email: Viewer screen

3. Edit the content of the “Encryption for Email: Viewer” screen.
4. Click Copy to Clipboard. The edited text is copied to the Clipboard.

Making the Contents of the Clipboard Private
You can make the contents of the Clipboard private using the Encryption for Email 
Wizard. The Encryption for Email Wizard works with files or text data on the 
Clipboard.

Note: This section discusses how to encrypt content on the Windows Clipboard. To use the 
Encryption for Email Wizard to encrypt files that are not on the Clipboard, see 
Working with Files on page 2-28.

To make the contents of the Clipboard private:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Clipboard > Make Private. The Encryption for Email Wizard appears.
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FIGURE 2-13.   Encryption Wizard: Select Encryption Keys screen

3. Enter your email address in the field labeled The data will be encrypted to this 
Identity and click Add.

Note: If you used the Encryption for Email Wizard previously, your email address is stored 
in the identities box. Ensure that the correct identity is selected.

4. Click Next. The Encryption for Email Wizard Complete screen appears.
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FIGURE 2-14.   Encryption for Email Wizard Complete screen

5. Click Finish. The encrypted text is on the Clipboard and can be pasted into any 
text editor.

Digitally Signing the Contents of the Clipboard
You can digitally sign the contents of the Clipboard using the Encryption for Email 
Wizard. 

Note: You can only digitally sign unencrypted Clipboard text. You cannot sign text that has 
already been encrypted or that is already digitally signed.

To digitally sign the contents of the Clipboard:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Clipboard > Sign. The Encryption Wizard appears.
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FIGURE 2-15.   Encryption Wizard: Select Encryption Keys (for signing)

3. From the Sign with drop-down list, select the email address (key) to use when 
digitally signing the text.

4. Click Next. The Encryption for Email Wizard Complete screen appears.
5. Click Finish. The signed text is on the Clipboard and can be pasted into any text 

editor.

Reading the Contents of the Clipboard
You can read the contents of the Clipboard using the Encryption for Email Wizard. The 
Encryption for Email Wizard works with files or text data on the Clipboard.

To read the contents of the Clipboard:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Clipboard > Decrypt/Verify. If you have not enabled password caching, 
the Encryption for Email Wizard appears.

3. Click Next. The “Encryption for Email: Enter your password” screen appears.
4. Select your email address from the list of available email addresses.
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5. Enter your password in the Password field. The “Encryption for Email Wizard 
Decryption Complete” screen appears.

FIGURE 2-16.   Encryption for Email Wizard Decryption Complete screen

Tip:  You can copy the decrypted text directly onto the Clipboard by selecting the 
“Put plain text on the clipboard” check box. Alternatively, you can copy the text 
to the Clipboard from the “Encryption for Email: Viewer” screen.

6. Click Finish. The “Encryption for Email: Viewer” screen appears showing the 
decrypted message, as shown in Figure 2-17.
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FIGURE 2-17.   Encryption for Email Viewer showing text decrypted 
from the Windows Clipboard

Working with Windows
You can make the content of the active window private. You can also read contents of 
windows that have previously been made private.

Note: The window operations are not supported on some versions of Windows. The 
Window menu therefore is not always available. If the active window is not supported 
by Encryption for Email, then the Window menu is unavailable.

The Window submenu contains the following options:
• Make Private, as described in Making Text Private in the Active Window on page 2-23
• Sign as described in Digitally Signing Text in the Active Window on page 2-23
• Decrypt/Verify as described in Reading Text in the Active Window on page 2-24
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Making Text Private in the Active Window
You can select and make text private in the active window without copying it to the 
Clipboard first.

To make text private in the active window:
1. Click the window containing the text to make it the active window.

Note: Some applications, for example Microsoft Word, require that you highlight the 
text prior to making the text private.

2. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

3. Select Window > Make Private. The Encryption for Email Wizard window 
appears.

4. Complete the Encryption for Email Wizard, as described in Making the Contents of the 
Clipboard Private on page 2-17.

Digitally Signing Text in the Active Window
You can select and digitally sign text in the active window without first copying it to the 
Clipboard.

To digitally sign the text in the active window:
1. Click the window containing the text to make it the active window.

Note: Some applications, for example Microsoft Word, require that you highlight the 
text prior to signing the text.

2. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

3. Select Window > Sign. The Encryption for Email Wizard window appears.
4. Complete the Encryption for Email Wizard, as described in Digitally Signing the 

Contents of the Clipboard.
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Reading Text in the Active Window
You can read private text in the active window, for example, email received in a web mail 
account.

To read private text in the active window:
1. Click the window containing the private text to ensure that the window is the active 

window.

Note: Some applications, for example Microsoft Word, require that you highlight the 
text before starting the Encryption for Email Wizard.

2. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

3. Select Window > Decrypt/Verify from the Encryption for Email menu. The 
Encryption for Email Wizard window appears.

4. Complete the Encryption for Email Wizard, as described in Reading the Contents of the 
Clipboard on page 2-20.

Removing Cached Passwords
You can remove all cached Encryption for Email passwords from your computer. You 
may wish to do this, for example, if you are sharing your computer and do not want 
other people to have access to your private files.

You instruct Encryption for Email to forget passwords in two ways:
• By using the Forget Passwords option from the Encryption for Email menu
• By using the Password Options when configuring Encryption for Email, as 

described in Preferences Screen Password Options Tab on page 4-5

To forget passwords using the Encryption for Email menu:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Forget Passwords and click Yes in the confirmation message that appears. 
Your Encryption for Email passwords are removed from your computer.
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Closing Encryption for Email
If you want to close the Encryption for Email tray application, you can use the 
Shutdown option in the Encryption for Email menu.

To close Encryption for Email:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Shutdown > Exit. Encryption for Email shuts down.

Restarting Encryption for Email
If you want to restart the Encryption for Email tray application, you can use the 
Shutdown option in the Encryption for Email menu.

To restart Encryption for Email:

1. Click the Encryption for Email icon ( ) in the Windows system tray. The 
Encryption for Email menu appears.

2. Select Shutdown > Restart. The Encryption for Email tray application restarts.

The Encryption for Email Status Screen
The Encryption for Email Status screen provides information useful for diagnosing 
support issues with the Encryption for Email software and might be requested by your 
support provider when troubleshooting.
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To show the Encryption for Email Status screen:

1. Hold down the Ctrl key and click the Encryption for Email icon ( ) in the 
Windows system tray. The Encryption for Email Advanced menu appears.

FIGURE 2-18.   Encryption for Email Advanced menu

2. Select Status. The Encryption for Email Status screen appears in your default web 
browser.
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FIGURE 2-19.   Encryption for Email Status screen

Note: You can save the Encryption for Email Status as an XML file to send to support. Do 
so by clicking on the View Status Page as “XML File” link.
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Working with Files
You can make files private directly in Windows Explorer. For example, if you share a 
computer you can make your files private so that no other user can open these files 
without your password.

Making Files Private with Windows Explorer

To make files private in Windows Explorer:
1. Open Windows Explorer.
2. Select the files to make private.
3. Do one of the following:

• Right-click and select Make Private from the Encryption for Email submenu
• In Windows Explorer, click File >Encryption for Email > Make Private

• Copy the files to the Clipboard and select Make Private from the Encryption 
for Email Tools menu, as described in Making the Contents of the Clipboard Private 
on page 2-17
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FIGURE 2-20.   Encryption for Email Make Private submenu in Windows 
Explorer

The Encryption for Email Wizard Select a Destination window appears.
4. Select the folder that the private files are to be saved in using Browse.
5. Click Next. The Encryption for Email Wizard Select Encryption Keys screen 

appears.
6. Enter your email address in the field labeled The data will be encrypted to this 

Identity and then click Add.

Note: If you have previously used the Encryption for Email Wizard, your email address 
is stored in the identities box. Ensure that the correct identity is selected.

7. Click Next. The Encryption for Email Wizard Complete screen appears.
8. Click Finish. A new folder window appears showing the private files in the selected 

folder.
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Decrypting Files with Windows Explorer
Once Encryption for Email is installed, you can decrypt private files in Windows 
Explorer.

To decrypt private files in Windows Explorer:
1. Open Windows Explorer.
2. Select the private files to decrypt.
3. Do one of the following:

• Right-click and select Decrypt from the Encryption for Email submenu that 
appears

• Select Decrypt from the Encryption for Email submenu from the Windows 
Explorer File menu

• Copy the files to the Clipboard and select Decrypt from the Encryption for 
Email Tools menu, as described in Reading the Contents of the Clipboard on 
page 2-20

The Encryption for Email Wizard Select a Destination screen appears.
4. Use Browse to select the folder to save the private files to.
5. Click Next. The “Encryption for Email: Enter your password” screen appears 

unless you enabled the “remember passwords” option in Preferences > Password 
Options.

6. Select your email address from the list of available email addresses.
7. Type your password. The Encryption for Email Wizard Complete screen appears.
8. Click Finish. A new folder window appears showing the decrypted files in the 

selected folder.

Note: If you cleared the “Show decrypted files” check box, this window is not displayed.
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Opening Private Files with Windows Explorer
Once you have installed Encryption for Email, you can open private files in Windows 
Explorer.

Note: If opening private files in this way, any changes that you make to such a file will not 
be saved back to the private file when you close it.To edit the file, decrypt it first, edit 
it, save it, and then decrypt it again.

To open a private file with Windows Explorer:
1. Do one of the following:

• Right-click and select Open Private File from the Encryption for Email 
submenu.

• Select Open Private File from the Encryption for Email submenu from the 
Windows Explorer File menu.

• Double-click the private file in Windows Explorer.
2. If more than one email address is registered for this account, select your email 

address from the list shown.
3. If prompted, type your password.
4. Click OK. The private file is opened in the application associated with the file type.
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Chapter 3

Receiving Private Email Without 
the Client

Topics include:
• Using the Zero Download Reader on page 3-2
• Reading a Private Email Message on page 3-4
• Registering on the Web on page 3-16
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Introduction
If you do not have access to an email program that is integrated with Trend Micro 
Encryption for Email, you can access private email messages securely on the web 
through the Trend Micro Zero Download portal.

You may need to read private messages without the Encryption for Email plug-in for 
several reasons:
• You use web mail, such as Gmail, Yahoo Mail, or Mozilla Thunderbird.
• You use an email program that cannot integrate with Encryption for Email, such as 

Mozilla Thunderbird.
• You are using a computer that does not have Encryption for Email installed.

Using the Zero Download Reader
If you receive an encrypted email message in your web mail account or in an 
unsupported email program, you can read it using the Zero Download Reader.

Use the Zero Download Reader to:
• Read encrypted email messages
• Copy the contents of a private email message to another application
• Print the contents of a private email message

You must register your email address with Zero Download before you can read a private 
message sent to that address. However, someone using Encryption for Email can send 
you a private message even if you have not registered yet. Zero Download detects that 
the email address has not yet been registered and then helps you to register on the web 
just before you open the private message.

To use the Zero Download Reader to open a private email message sent to a 
registered email address:
1. Open the message that you received in your web mail account. The open message 

displays the Encryption for Email envelope.
2. Click to download the file attachment named Encrypted_Message.htm. You are 

prompted to Open or Save the file.
3. Click Save to save the Encrypted_Message.htm file to your selected directory.
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4. Select File > Open, and then select the Encrypted_Message.htm file to open 
the message. Your browser opens to the Encryption Portal screen.

5. Click Open Message. The Zero Download “Enter your email address” screen 
appears.

Note: If you have recently used Zero Download to read an encrypted message sent to 
the same email address that you are checking, that email address may still be 
stored in your browser cache. If so, you do not have to reselect your email 
address on the Zero Download “enter your email address” screen; the Account 
Verification screen opens instead.

6. Select your email address from the drop-down list next to the Enter your email 
address if you received this email field and click Continue.  
The Account Verification screen opens.

7. Verify your account as explained in Verifying Your Account on page 3-8. The 
decrypted message displays in your browser window.

To use Zero Download Reader to open a private email message sent to an 
unregistered email address:
1. Follow Step 1 through Step 4 in the procedure, To use the Zero Download Reader to open 

a private email message sent to a registered email address: on page 3-2.
2. Select your email address from the drop-down list next to the Enter your email 

address if you received this email field and click Continue.  
The Email Address Not Registered screen appears.

3. Select the “I certify that I have read and agree to the License and Terms” check 
box. The Register button becomes enabled.

4. Click Register. The Register Encryption Account screen appears, displaying your 
recipient email address as your “identity” for encryption. Follow the registration 
procedure explained in Registering on the Web on page 3-16.
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FIGURE 3-1.   Zero Download Reader window

Reading a Private Email Message
Using Private Post Zero Download, you can read private messages on any computer, 
regardless of its operating system and whether or not Encryption for Email is installed.

To open a private email message using Private Post Zero Download:
1. Open the received message as usual. The opened message displays the Encryption 

for Email envelope.
2. Click to download the file attachment with the name Encrypted_Message.htm. 

You are prompted to Open or Save the file.
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3. Click Open. The Encryption Portal screen displays in your web browser.

FIGURE 3-2.   Encryption Portal initial screen

4. Click Open Message. The Zero Download Reader login screen appears.

FIGURE 3-3.   Zero Download Reader login screen
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5. Select your email address from the drop-down list or type it in the field.
6. Click Continue.

• If the email address is already registered, the Account Verification screen 
appears. 

• If the email address has not yet been registered, the Email Address Not 
Registered screen appears.

Note: If you have not registered this address with Encryption for Email, complete the 
two-part registration process, as explained in Registering on the Web.

7. Verify your account as explained in Verifying Your Account on page 3-8.
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8. Click Continue. The authentication window is now closed, and the plain text 
message is shown in the original window.

FIGURE 3-4.   Encryption for Email Message Decrypted using the Zero 
Download Reader
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Composing a Private Message
From within the Zero Download Reader, you can forward, reply or “reply all” to a 
received encrypted message.

Send Private
The interface is not significantly different from any other web-based email composition 
screen, except for one thing: the “Send” button is actually a “Send Private” button. The 
button has this label because you can forward or reply to an encrypted message only in 
encrypted form.

Different Appearance Without JavaScript
• When JavaScript is enabled, the interface contains a recognizable set of email 

composition tools, arranged at the top and identified by icons and mouse-over 
labels.

• When JavaScript is disabled, the interface contains only plain text.

Verifying Your Account
The Account Verification screen displays differently depending on whether JavaScript is 
enabled in your browser, as shown in Figure 3-5 and Figure 3-7 below. If JavaScript is 
disabled, the label, “JavaScript is disabled” appears at the top right. For more 
information about how the user interface looks different without JavaScript, see 
JavaScript Is Disabled on page 3-15.

The Account Verification screen also has two views depending on security level:
• “Low security” view: contains a conventional password field, along with an 

identification word and a security question, as shown in Figure 3-5. Low-security 
Account Verification screen on page 3-9.

• “Enforced security” view: contains a more complex password field with a 
character-position test, as explained in Using the Password Character-Matching Test 
in Enforced Security Mode on page 3-14 and as shown in Figure 3-7. Enforced security 
Account Verification screen on page 3-11.
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Low Security View
Use the low security view in safe places, like your home.

FIGURE 3-5.   Low-security Account Verification screen 

To verify your account in the Account Verification low security screen:
1. Type your Password in the field provided.
2. Answer the security question shown.
3. Accept the default value of 8 hours in the “Keep me signed in” field, or select one 

of the other available options:
• 1 hour
• 5 minutes
• Never

4. Click Continue. The decrypted message displays in your web browser.

Note: After two failed login attempts, the Account Verification screen displays a CAPTCHA 
bot code widget, for greater security, as shown in Figure 3-6.
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FIGURE 3-6.   Account Verification screen, low security mode, after two 
failed login attempts
3-10



Receiving Private Email Without the Client
Enforced Security View
Use the enforced security view when accessing your email on a public computer or 
whenever you need enhanced security.

FIGURE 3-7.   Enforced security Account Verification screen 
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FIGURE 3-8.   Enforced security Account Verification screen, with 
JavaScript disabled
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FIGURE 3-9.   Low-security Account Verification screen, with JavaScript 
disabled

To verify your account in the Account Verification high security screen with 
JavaScript enabled:
1. In the three randomly selected password-character fields, type the individual 

characters of your Password based on their position, as explained in Using the 
Password Character-Matching Test in Enforced Security Mode on page 3-14.

2. Answer the security question shown.

Note: In this view, for added security, your answer to the security question displays only 
as asterisks.

3. Accept the default value of 5 minutes in the “Keep me signed in” field or select 
one of the other available options:
• 8 hours
• 1 hour
• Never

4. Click Continue. The decrypted message displays in your web browser.
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Using the Password Character-Matching Test in Enforced 
Security Mode
In “enforced security” mode, Encryption for Email prompts you to enter only certain 
characters of your password. This method prevents key loggers from capturing your 
entire password even if your computer is compromised.

For example, if the form asks you to enter the “3rd, 5th, and 8th” characters and your 
password is “ZeroDownload,” then you would enter characters as follows:

What is your 
password?

r D n
3rd 5th 8th …password character

Z e r o D o w n l o a d
Character
order: 1 2 3 4 5 6 7 8 9 10 11 12

FIGURE 3-10.   Password character-matching test (“enforced security” 
mode only)

In the example above, the characters shown in the “What is your password” fields match 
the character positions requested.

Note: 1. Do not use “ZeroDownload” as a password, because it is too easy to guess. 
 
2. The password is case-sensitive.
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JavaScript Is Disabled
The notation “JavaScript Is Disabled” displays at the top right of your screen if your 
browser is set to disallow JavaScript. When JavaScript is enabled, your browser uses 
ActiveX (if Internet Explorer) or a Firefox extension to do the decryption locally. When 
JavaScript is disabled, Zero Download still works, but for technical reasons must post 
your message to a Private Post server for decryption and then send it back to you in a 
secure transport mode (https://). 

Private Post securely deletes the message copy on the server once you have viewed the 
message.

Apart from the above change in back-end processing, there are a few, minor differences 
in the user interface of various screens when JavaScript is disabled.

ToolTips Function Differently
ToolTip icons ( ) do not display text when you place your mouse pointer over them. 
Instead, you must click them in order for the message to display, and it displays in a 
small “pop-up” browser window. 

No Password Strength Meter
Without JavaScript, the password-strength meter on the Register Encryption Account 
screen does not appear.

Three Fields, Not Two
When JavaScript is disabled, the Zero Download “enter your email address for 
authentication” sign-in screen displays three fields instead of two:
• Select your email address (drop-down list)
• Type your email address if it’s not listed

• You sent this secure email

When JavaScript is enabled, you can either select from the “Select your email address” 
drop-down list or type directly into the field.
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Registering on the Web
If you have never installed Encryption for Email but you have received a private email 
message, you can register your email address to read the private message without having 
to download and install the Encryption for Email client.

After you have registered on the web, you can read your private message. You can also 
transfer this registration to a new or existing Encryption for Email software installation 
(see Using Encryption for Email on Multiple Computers).
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FIGURE 3-11.   Register Encryption Account screen
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The Register Encryption Account screen consists of three main sections:
• Select a Password on page 3-18
• Select and Answer Security Questions on page 3-19
• Select an Identification Word on page 3-19

Complete all three sections to complete your registration.

Select a Password
In this section is a helpful password-strength indicator to help you create a strong 
password, as shown in Figure 3-12 below.

FIGURE 3-12.   Register Encryption Account screen, Select a Password 
section

Trend Micro Encryption for Email passwords have the following requirements:
• Must be at least seven (7) characters long
• Cannot contain spaces or ampersands (“&” characters)

Note: Your password is case-sensitive. For a stronger password, include special characters, 
such as numbers and symbols (except the ampersand [&] symbol).
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Select and Answer Security Questions
In the Security Questions section, you must select and answer three separate questions, 
one of which will randomly display when you log in later. Be sure to select questions 
whose answers you will always remember, as you can log in only if you answer this 
question correctly. 

FIGURE 3-13.   Register Encryption Account screen, Select Security 
Questions section

Select an Identification Word
Type an identification word here. Your identification word helps if you need to reset a 
lost password. Its purpose is to prove that the Reset Password screen that you are 
looking at is valid and not a phishing site.

When you see your identification word, you know that it is safe to answer the security 
questions shown.

To register your email address on the web:
1. Open the received email message in your browser using web mail and follow the 

instructions for reading a private email in To open a private email message using Private 
Post Zero Download: on page 3-4. Because you have not yet registered the selected 
email address, the Email Address Not Registered screen appears.

2. Click Register Now. The Register Encryption Account screen appears, as shown 
in Figure 3-11 on page 3-17.
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3. Optionally, to change the email address shown, click Change and select or enter a 
different email address in the screen that displays.

4. Type and confirm a Password.

5. Select and answer three required Security Questions.

6. Type an Identification Word, which you can use if you ever forget your password.
7. In the Type the Code field, type the graphical code shown, which verifies that you 

are not an automated script.
8. Click Continue. Private Post sends an activation email to your recipient web mail 

account.

Tip:   If you do not receive the activation message from Private Post within a minute 
or so, check your Spam folder. Such messages often end up there.

9. Access your recipient web mail account, open the activation message, and click the 
“Please click here to validate your identity” link. 
Your browser is redirected to a verification screen with password and security 
question fields.

10. Type your password and answer your previously selected security question.
11. Click Continue. Your email address is now registered to read private email 

messages using Encryption for Email Zero Download.

You can now return to the downloaded “Encrypted_Message.htm” file and read the 
private message as explained in Reading a Private Email Message on page 3-4.
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Chapter 4

Configuring Encryption for Email

After installing Encryption for Email and registering an email address, you can configure 
the software to meet your individual needs. 

Topics include:
• Accessing the Preferences Screen on page 4-2
• Managing the Encryption for Email Keys on page 4-9
• The About Encryption for Email Window on page 4-17
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Accessing the Preferences Screen
You can access the Encryption for Email Preferences screen either:
• From the Encryption for Email menu, as described in Using the Encryption for Email 

Tray Tool on page 2-9
• From the Preferences icon in any Encryption for Email application, such as your 

email program, as described in Using Encryption for Email in Your Email Program on 
page 2-2

Note: When using Encryption for Email in a corporate environment, your corporate 
administrator might have set the values of some sections for you and hidden those 
controls from view.

Preferences Screen General Options
The Encryption for Email Preferences window contains five tabs. By default it opens on 
the General Options tab. On this tab you can select the email address that is always able 
to read private messages. There might be many email addresses on your computer if 
different users access their email from this computer.
4-2



Configuring Encryption for Email
FIGURE 4-1.   Preferences screen: General Options tab

Note: All of the options in the tabs shown in Figure 4-1 can be configured separately for 
each email address. If you have more than one registered email address, select and 
configure each address separately.

To change the default email address:
1. From the Select an address to configure drop-down list, select the email address 

to use as the default.
2. Click Set as default.
3. Click Apply or OK to save the setting.
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Preferences Screen Email Options Tab
The options listed in the Email Options tab are only used if you have a supported email 
client. (See System Requirements for a full list of supported email clients.)

FIGURE 4-2.   Encryption for Email Preferences, Email Options tab

On this tab you can select the following options:
• Make new messages private by default
• Automatically open Private Post messages
• Display digital signature information
• Warn about invalid digital signatures
• Opened messages should remain decrypted
• Choose between the following two message formats:

• Messages and attachments are encrypted individually
• Messages and attachments are encrypted together
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To change any settings on the Email Options tab:
1. From your email program, click Preferences on the Encryption for Email main 

bar. The Preferences window opens.
2. Click the Email Options tab.
3. Select or clear the check box next to each option to change.
4. Click Apply to save your changes.

Preferences Screen Password Options Tab
On the Password Options tab you can configure:
• Whether the system automatically remembers passwords
• The length of time passwords are remembered

FIGURE 4-3.   Encryption for Email Preferences, Password Options tab
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To set Encryption for Email to remember passwords:
1. Open the Encryption for Email Preferences screen as explained in Accessing the 

Preferences Screen on page 4-2.
2. Click the Password Options tab.
3. Select the Enable remembering of passwords check box.
4. From the Remember passwords for drop-down list, select the length of time to 

remember passwords from the following options:

Note: If you select the Windows Session option, you will only have to enter your 
password once during a single Windows logon session.

5. Click Apply to save your changes.

Preferences Screen Automatic Update Tab
On the Automatic Update tab, you can configure how you receive automatic software 
updates.

By default, Encryption for Email checks for updates every 24 hours and immediately 
after installation, as described in Checking for Updates on page 1-20.

If the Enable Automatic Updates (Recommended) check box is selected, updates 
are automatically downloaded and installed. If the check box is not selected, when an 
update is available, you are asked whether you want to download and install the update.

• Windows Session • 15 minutes
• 1 minute • 30 minutes
• 5 minutes • 60 minutes
• 10 minutes
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FIGURE 4-4.   Encryption for Email Preferences, Automatic Update tab
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Preferences Screen Network Options Tab

.
FIGURE 4-5.   Encryption for Email Preferences, Network Options tab

To enable the use of a proxy server:
1. Open the Encryption for Email Preferences screen as described in The About 

Encryption for Email Window on page 4-17Accessing the Preferences Screen on page 4-2.
2. Click the Network Options tab.
3. Select the Use Proxy Server check box.
4. Type the Proxy server name or address.
5. Type the Proxy server port.
6. If the proxy server requires authentication, type your User name and User 

password in the fields provided.
7. Click Apply to save your changes.
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Managing the Encryption for Email Keys
Encryption for Email includes a tool for managing encryption keys. Use the Encryption 
for Email Key Manager to:
• View the Encryption for Email keys on your system, as described in Viewing the 

Encryption for Email Keys on page 4-11
• Export the Encryption for Email keys, as described in Exporting the Encryption for 

Email Keys on page 4-13
• Delete the Encryption for Email keys, as described in Deleting the Encryption for Email 

Keys on page 4-15
• Protect a new email address, as described in Protecting a New Email Address on 

page 4-16

To open the Encryption for Email Key Manager:

1. From the Windows Start menu, click Start > Programs > Trend Micro 
Encryption for Email > Key Manager, as shown in Figure 4-6. The Key Manager 
window opens.

FIGURE 4-6.   Accessing the Encryption for Email Key Manager
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2. Alternatively, hold down the Ctrl key and click the Encryption for Email icon in the 
Windows system tray to open the advanced menu, as shown in Figure 4-7.

FIGURE 4-7.   Accessing the Key Manager from the tray icon advanced 
menu

3. From the pop-up menu that appears, Select Key Manager. The Key Manager 
window opens.

The Encryption for Email Key Manager window is divided into three panes:

Left pane: shows the key hierarchy with keys grouped by their identity

Top right pane: shows the individual keys within the group selected in the left 
pane

Bottom right pane: shows the details of the selected key
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FIGURE 4-8.   Encryption for Email Key Manager window

Viewing the Encryption for Email Keys
Using the Encryption for Email Key Manager, you can view the details of a private or 
public key.

To view the details of a key:
1. From the Windows Start menu, click Start > Programs > Trend Micro 

Encryption for Email > Key Manager. The Key Manager opens.
2. In the top right pane, select the key.
3. Do one of the following:

• Right-click the key and then select View Key from the Key menu
• Double-click the key in the top right pane of the Encryption for Email Key 

Manager
The Certificate window appears, as shown in Figure 4-9.
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FIGURE 4-9.   Key Manager Certificate window, General tab

4. Click the Details tab. The Certificate window displays detailed information about 
the key, as shown in Figure 4-10.
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FIGURE 4-10.   Key Manager Certificate window, Details tab

Exporting the Encryption for Email Keys
You can export private and public keys.

You might want to export your private key if, for example, you are going to use a 
computer that has no network access but you have private files saved on it. You can save 
the private key to a disk or USB drive and then import it to the offline computer using 
the Encryption for Email Key Manager.

You might want to export your public key, for example, to make files private on an 
offline computer.
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To export a key:
1. Select the key to export from the key pane in the top right of the Encryption for 

Email Key Manager window.
2. Right-click the key and select Export Key from the Key menu.

FIGURE 4-11.   Encryption for Email Key Manager: Export Key

3. The Save As window appears.
4. Keep the key name shown or rename it before saving it locally.

Note: The Encryption for Email Key Manager saves exported keys with a *.pppub 
file extension for public keys and a *.ppprv extension for private keys.

5. Click Save. Encryption for Email exports the key and then displays a “successfully 
exported” message.

6. Click OK.
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Deleting the Encryption for Email Keys
If you are using a shared computer, you might want to delete your keys for privacy 
reasons and reinstall them each time you use that computer.

Note: If the email address of the message recipient is registered and you try to read a private 
message on a computer that does not have the private key, Encryption for Email 
automatically downloads the key.

To delete a key:
1. From the key pane in the top right of the Encryption for Email Key Manager 

window, select the key to delete.
2. Right-click the key and select Delete Key from the Key menu.

FIGURE 4-12.   Encryption for Email Key Manager, Delete Key

3. A confirmation window appears.
4. Click Yes.
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Protecting a New Email Address
You can launch the Encryption for Email Protection Wizard from the Encryption for 
Email Key Manager.

To launch the Encryption for Email Protection Wizard from Key Manager:
1. Open the Key Manager, as described in Managing the Encryption for Email Keys starting 

on page 4-9.
2. From the Key Manager menu, select Key Manager > Register New Email 

Address, as shown in Figure 4-13.

FIGURE 4-13.   Registering a new email address from within Key 
Manager 

3. The Protect Email Address Wizard starts.
4. Complete the Wizard, as described in Protecting Your Email Address on page 1-16.
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The About Encryption for Email Window
About Encryption for Email is an informational window that displays software 
installation information, copyright notices, and user information.

You can access the About Encryption for Email window:
• Through the Encryption for Email menu on the Windows system tray
• By clicking About Encryption for Email in any Encryption for Email application 

or email program plug-in

To view the About Encryption for Email window from the Encryption for Email 
menu:
1. Click the Encryption for Email icon in the Windows system tray. The Encryption 

for Email menu appears.
2. Select About Encryption for Email from the menu. The About Encryption for 

Email window appears.

FIGURE 4-14.   About Encryption for Email window
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The Encryption for Email Modules Screen
You can access the Encryption for Email Modules screen from the About Encryption 
for Email window. It shows the versions of all files installed during the Encryption for 
Email software installation. This information is provided for support purposes only.

To view the Encryption for Email Modules screen:
1. Click the Encryption for Email icon in the Windows system tray. The Encryption 

for Email menu appears.
2. Select About Encryption for Email from the menu. The About Encryption for 

Email window appears.
3. Click Modules. The Encryption for Email Modules window appears.

WARNING! The Modules tool is intended for use by Support staff when trouble shoot-
ing. Use the Modules window at your own risk. Trend Micro accepts no 
responsibility for sensitive data that may be compromised if you use this 
tool without direct guidance from Support.
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Chapter 5

Managing Your Account Online

Using the My Private Post website, you can manage your Encryption for Email account.

Topics include:
• My Private Post on page 5-2
• Signing in to the My Private Post Website on page 5-2
• Removing Encryption for Email on page 5-6
• Managing Your Security Questions on page 5-4
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My Private Post
On the My Private Post website, you can manage your security questions and answers. 
The website also provides many useful features that are explained on the site itself.

Signing in to the My Private Post Website
The My Private Post website requires that you sign in. After signing in, you can use 
manage your security questions and access other useful features.

To sign on to the My Private Post website:
1. Copy and paste the following URL into the address field of your browser:

https://www.myprivatepost.com/
The Private Post website loads in your browser.

FIGURE 5-1.   The My Private Post website, initial view

2. Click the Sign In link. The Private Post Sign In screen appears in your web browser 
window.
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FIGURE 5-2.   My Private Post Sign-in screen

Tip:  If you have Encryption for Email installed and are using the Microsoft Internet 
Explorer, you might see the yellow information bar asking if you want to run the 
Encryption for Email Sign On Control from Trend Micro.  
 
Use of this ActiveX control enables a much easier sign-on process. (For more 
information about the Sign-On control, see Private Post Sign On Control on page 5-3.

3. Type your Email Address.
4. Select one of the following:

• I have the Private Post tools installed on this computer

• I do not have the Private Post tools installed on this computer

5. Click Next.
6. Follow the instructions on the website to complete the sign-in process. You are now 

signed in to the My Private Post website.

Private Post Sign On Control
The Private Post Sign On Control enables you to quickly and easily sign in to the My 
Private Post website if you have the Encryption for Email software installed and are 
using Microsoft Internet Explorer.
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FIGURE 5-3.   My Private Post Sign In when using the Encryption for Email 
Sign On Control

To use the Private Post Sign On Control:
1. Select your email address from the drop-down list.
2. Click Sign In. The “Private Post: Please enter your password” window appears.
3. Type your password in the field provided and click OK. The My Private Post 

website accepts your registered email address and displays a message indicating that 
you have successfully signed in.

Managing Your Security Questions
After you are signed in to the My Private Post website, you can manage your security 
questions.

To manage your security questions:
1. Sign on to the My Private Post website, as described in My Private Post on page 5-2. 

The My Private Post Sign In screen appears showing the message, “Thank you - you 
are now signed on.”

2. On the left menu, click My Settings. The Private Post Login Details appears, as 
shown in Figure 5-4.
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FIGURE 5-4.   Private Post Login Details screen

3. Update your login details by following the instructions on the website.
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Removing Encryption for Email
You can uninstall Encryption for Email using the Encryption for Email Uninstall 
Wizard.

To uninstall Encryption for Email:
• Do one of the following:

• From the Windows Start menu, click Start > Programs >Trend Micro 
Encryption for Email > Uninstall, as shown in Figure 5-5.

• Access Windows Control Panel and use the Add/Remove Programs tool to 
uninstall the program.

FIGURE 5-5.   Uninstalling Encryption for Email from the Windows 
Start menu
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